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Introduction

1 INTRODUCTION

This document details the operation and setup requirements of the DSEM812 Qt Controller and
Display, part of the DSEControl® range of products.

DSEM812 CODESYS variants are not covered in this document and are detailed within DSE
Publication 057-318 DSEMS812 CODESYS Manual.

Hardware, Specifications, Settings Pages and Installation Notes for all DSEM812 variants are detailed
within DSE Publication 057-317 DSEMS812 Operator Manual.

Knowledge of Linux and Qt (QML, C++ and JavaScript) is essential and assumed. This manual
instructs the Qt programmer how to use Qt in conjunction with the DSE device. This manual does not
give instruction for Linux, Qt, QML, C++ or JavaScript.

The manual forms part of the product and should be kept for the entire life of the product. If the
product is passed or supplied to another party, ensure that this document is passed to them for
reference purposes.

This is not a controlled document. DSE do not automatically inform on updates. Any future updates of
this document are included on the DSE website at www.deepseaelectronics.com

Observe the operating instructions. Non-observance of the instructions, operation not in accordance
with use as prescribed below, wrong installation or incorrect handling seriously affects the safety of
the product, operators and machinery.

A robust metal case designed for chassis mounting houses the module. Connections are via locking
plug and sockets.

The controller is supplied with no application program. The equipment manufacturer is responsible for
creating and managing the application program and installing it in the controller. This is achieved
using Qt programming. Contact DSE Technical Support for further details.

Qt is an application development framework for Linux Embedded systems.
Qt is not a programming language on its own. It is a framework written in C++ using signals and slots
to pass information to/from Qt Modelling Language files (QML).
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Introduction

1.1 CLARIFICATION OF NOTATION

Clarification of notation used within this publication.

ANOTE' Highlights an essential element of a procedure to ensure correctness.

A | Indicates a procedure or practice, which, if not strictly observed, could
CAUTION! result in damage or destruction of equipment.

Indicates a procedure or practice, which could result in injury to
WARNING! personnel or loss of life if not followed correctly.

1.2 GLOSSARY OF TERMS

Term Description

Application The application is the program that allows the DSEM812 to control the
machine it is connected to.

The Application within the DSEM812 is designed and provided by the
manufacturer of the complete machine.

Bootloader The Bootloader is the program within the DSEM812 responsible for loading
the Operating System.

C++ Programming language used alongside QML to create the complete
application program.

CAN Control Area Network. A high-speed data transmission system used
extensively within the Automotive and Off-Highway industries.

Deploy The compiled application is ‘deployed’ to the device folder /home/m812

ECU Electronic Control Unit. For example, the DSEM812 device.

Firmware The Firmware of the DSEM812 is the Operating System of the DSEM812
that reads and executes the Application program.

FSD Full Scale Deflection. For example, 0 mA to 20 mA is the Full Scale

Deflection of a current sink input.
Input / Output. For example, “The 1/O is taken out to an external terminal

I/O O »
strip in the user panel’”.
Integrated Development Environment. For example, the Qt application that

IDE runs on the host PC is an IDE, containing code editors, compilers and
much more.

Ixyyy An Input, where x is the connector and yyy is the input number. For
example, IBO03 means Input 3 on Connector B.

Nano An editor to allow text files to be altered.

PLC Programmable Logic Controller. Industrial computer used primarily for the
automation of electromechanical machinery.

PWM A digital signal is used to represent an analogue value by using Pulse

PWMi Width Modulation. The mark-space ratio of a square wave changes to

represent the value.

Used for many control applications including proportional valves.

PWM= Voltage control.

PWMi = Current control.

Off-Highway An industrial vehicle used primarily “off road”. For example construction
and farm machinery. A wider interpretation includes on road access
platforms, emergency vehicles and other industrial machinery, used either
on the road, or off road.

Pin A male or female pin connection in a housing (plug or socket).
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Introduction

QML Qt Modelling Language. Used to design/describe the display elements on
the DSEM812 Qt variant.

Qt Application development system supported by DSEM812 Qt Variant
Pronounced ‘Cute’.

Qxyyy An Output, where x is the connector and yyy is the output number. For
example QB002 means Output 2 on Connector B.

Remote Shell A terminal to allow commands to be run on the target device.

Run.sh Shell program executed at device boot time. Among other functions, this
file instructs the device which application to execute at boot of the device.

1.3 RELATED INFORMATION

This document refers to and is referred by the following DSE publications which are obtained from the
DSE website: www.deepseaelectronics.com or by contacting DSE technical support: support@
deepseaelectronics.com.

1.3.1 TECHNICAL INFORMATION

DSE Part Description

055-267 DSEM812 Datasheet
057-317 DSEM812 Operator Manual
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Introduction

1.4 SAFETY INSTRUCTIONS

1.4.1 GENERAL

These instructions are for authorised persons according to the EMC and low-voltage directives.
The device must be installed, connected and put into operation by a qualified electrician.

It is not permissible to open the controller or to modify or repair the controller. Modification or
repairs to the wiring could result in dangerous malfunctions. Repairs to the controller must be
performed by DSE. Contact your original equipment supplier in the case of malfunction.

When the device is unpowered, ensure that no connection pins are connected to a voltage
source. Thus, when the supply is switched off, the supply for the electronics, the power outputs
and the external sensor supply must be switched off together.

The controller heatsink at the rear heats up beyond normal ambient temperature during
operation. To avoid danger caused by high temperatures, protect against contact.

The customer is responsible for performing risk analysis of the mobile working machine and
determining the possible safety related functions. The user is responsible for the safe function of
the application programs created. If necessary, they must additionally carry out an approval test
by corresponding supervisory and test organisations according to the national regulations.

All connectors must be unplugged from the electronics during electrical welding and painting
operations.

1.4.2 INSTALLATION NOTES

Follow the instructions of the connector manufacturer, specifically with respect to preventing
water from entering the device. See Section entitled Cables, Connectors, Harnesses and Spare
Parts for details of DSE Part Numbers.

To maintain IP67 rating where connectors have unused pins, ensure the use of a suitable
Blanking Insert. In the case of a completely unused connector, the plug must be inserted, fully
populated with Pin Blanking Inserts. See Section entitled Cables, Connectors, Harnesses and
Spare Parts for details.

M12 protection plugs (supplied) must be installed in both the USB and Ethernet interfaces to
ensure IP67 rating when the connectors are not in use. Tighten to 0.8 Nm (0.6 Ibf ft). Where IP
protection is required when the interfaces are in use, suitable O-rings must be fitted.

The heatsink must be wired to vehicle ground to comply with EMC guidelines. A screw

connection point is provided for this purpose. A metallic screw must be used to create an
electrical connection to vehicle / machine ground.

Page 7 of 36 057-317 ISSUE: 0



Qt, C++ and QML

2 QT, C++ AND QML

ANOTE: Knowledge of Linux and Qt (QML, C++ and JavaScript) is essential and assumed.
This manual instructs the Qt programmer how to use Qt in conjunction with the DSE device.
This manual does not give instruction for Linux, Qt, QML, C++ or JavaScript.

Qt (pronounced ‘Cute’) is an application development system used by the Linux based DSEM812
devices. C++, QML and JavaScript are used to program the device.

QML is Qt Modelling Language, a mark-up language designed to aid development of user interfaces.
QML elements support JavaScript both inline and via included .js files.

QML is used to describe only the user interface. Where interaction with device hardware is required,
Integration with C++ is used.

Qt allows the use of externally programmed libraries to ‘extend’ the functionality of the system. This
includes the use of DSE supplied libraries to allow for example, the use of the device I/O.

C++ and QML work together to provide the full functionality of Qt.

Signal

C++ < Property > QML and JavaScript

< Slot

2.1 PROPERTIES, SIGNALS AND SLOTS

Properties, Signals and Slots are the mechanism that binds together C++ and QML. C++ classes
derived from QObject or a subclass are registered to allow them to be created as objects within QML.

e Properties are values associated with the object. QML reads and/or writes from/to the
properties. For example, a property of a class used to monitor the inputs of the device may be
read by the QML to know the voltage applied to the input.

e Signals are emitted by the C++ class upon specific actions occurring within the class.
Typically, a signal is emitted when a property value is changed in the C++ class. For example,
if a device input monitored by the C++ class changes value, a signal is sent to inform the
QML that the input has changed. Signal Handlers are used in the QML to act upon signals
from the C++.

e Aslotis a method of the class called when the property is changed by the QML. For example,
if the QML changes a property linked to the state of a device output, the C++ class detects
the change and calls the slot method that handles the setting of the class variable. In turn this
may also trigger a signal as the linked property has also changed.

Examples of properties, signals and slots are given in the following subsections.
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Qt, C++ and QML

2.1.1 SIGNALS

QObject Signals are emitted from C++ and typically used to trigger callback functions in the QML
JavaScript.

Signals are emitted by an object when it is required to inform about a change in the object. The Emit
keyword is used to do this.

Good practice dictates that a signal is used to indicate any properties that have changed.

2.1.1.1 PROPERTY DEFINITION

Within the class .h file a Q_PROPERTY is defined. In this example the property is read-only by the
QML due to the omission of a WRITE slot definition. For details of this, see section entitled Slot
Definition elsewhere in this document.

Name and type of the
property as presented

to QML
Q_PROPERTY (quint32 raw MEMBER mRaw MOTIFY rawChanged)
Parameter Description
MEMBER Defines the class variable that is used to link to the QML object
property. Such class variables are prefixed ‘m’ to indicate MEMBER.
NOTIFY Defines the signal emitted upon change of the property. The signal

must be prototyped in the .h file but does not required an associated
method creating in the .cpp file. The signal is automatically emitted
upon change of the property.

2.1.1.2 SIGNAL DEFINITION

Within the class .h file:
Definition of the signal method within class .h.

In this case the value of raw is passed as a

i 1s: i
s1gnals parameter of the function.

vo1d rawChanged(quint32 &raw);

2.1.1.3 SIGNAL USAGE

To receive a notification when a signal is emitted for an object, the object definition includes a signal
handler named on <Signal>, where <Signal> is the name of the signal, with the first letter capitalised.
The signal handler contains JavaScript code executed when the signal handler is triggered.

G”Ra‘f’gggﬁe{’éi eUolue oF rows "+iBOOL. rom: Definition of the signal handler
L EXL.TeXTs "Value o aW: +1 E=1 Wlthlna.qml f||e

! \ In this case the value of raw is
passed as a parameter of the

function.
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Qt, C++ and QML

2.1.2 SLOTS

QObject Slots are C++ methods that allow them to be called upon the change of a property.

The class .h file defines the C++ class a derived from QObject and defines methods as public slots to
make them accessible to QML.

2.1.2.1 PROPERTY DEFINITION

Within the class .h file a Q_PROPERTY is defined. In this example the property is read/Write.

Name and type of the
property as presented

to QML
Q_PROPERTY (bool state MEMBER mState  WRITE set5tate MNWOTIFY stateChanged)
Parameter Description
MEMBER Defines the class variable that is used to link to the QML object
property. Such class variables are prefixed ‘m’ to indicate member.
WRITE Defines the name of a method called when QML changes the value

of the property. This is used to control access to the class variable.
Typical application of the slot method is to check if the property value
has changed, validate the new property value, update the class
member variable with the new property value and finally emit a
signal to inform QML of the change.

NOTIFY Defines the signal emitted upon change of the property. The signal
must be prototyped in the .h file but does not required an associated
method creating in the .cpp file. The signal is automatically emitted
upon change of the property.

2.1.2.2 SLOT DEFINITION

Within the class _h file: Definition of the slot method Withir} class .h. !n this
example a pointer to the property is passed into
. the slot method. This is used to update the class

oublic slots: .
void setState(bool &state); variable.
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2.1.2.3 SLOT METHOD

In this example, a device output is controlled, based upon the value of the property pointed to in the
method call.

e The output is set to the state requested by the QML property state.

o If the property value of state has changed (if it is not the same as the class variable mState)
then the class variable is updated and the signal stateChanged is emitted, passing the
updated value along with the signal.

void Qutputs::setState(bool &state)
{

dse_io_output_set_state(static_cast<dse_io_output_pin_t>(mOutput), state);

if (state != mState) {
mState state;
emit stateChanged({mStote);
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Installing the Qt Environment

3 INSTALLING THE QT ENVIRONMENT

ANOTE: DSEvm.zip containing the Virtual Disk Image is available from
support@deepseaelectronics.com.

Extract the VDI (Virtual Disk Image) from the containing zip file. The extracted image is over 6 GB.
The VDI is designed to be used by Oracle VM VirtualBox PC software and provides a Ubuntu
operating system with Qt 5.1 preinstalled and configured for use with DSEM812.

VirtualBox is available from https://www.virtualbox.org/wiki/Downloads

3.1 PACKAGE INSTALL
Install VirtualBox. A new machine needs to be created with the supplied virtual disk image.

3.1.1 CREATING THE MACHINE
/ First select New

¥¥ Oracle VM VirtualBox Manager - O *

Eile  Machine Help

7 & AR

Preferences Import Export

Mew [(Ctrl+ M)

Windows Welcome to VirtualBox!
O Inaccessible The left part of application window contains global tools
and lists all virtual machines and virtual machine groups on
your computer. You can import, add and create new WMs
using corresponding toolbar buttons. You can popup a
tools of currently selected element using corresponding
element button.

‘fou can press the F1 key to get instant help, or visit
wowwy virtualbox. org for more information and latest news.
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Installing the Qt Environment

Then enter a name, select a folder and select Linux, Ubuntu (64-bit):

Create Virtual Machine

Name and operating system

Please choose a descriptive name and destination folder for the new virtual
machine and select the type of operating system you intend to install on it, The
name you choose will be used throughout VirtualBox to identify this machine.

Mame: |L|:|rem Ipsum |

Machine Folder: | C:Uzers\Public\Documents

Type: | Linux = E;L,

Version: |Ubuntu (64-bit)

Expert Mode Cancel

Then select Next, use a minimum of 1GB of memory.

Select Next and choose “Use an existing virtual disk file” and select the supplied virtual disk image:
? *

£ Create Virtual Machine

Hard disk

If you wish you can add a virtual hard disk to the new machine. You can either
create a new hard disk file or select one from the list or from another location

using the folder icon.

If you need a mare complex storage set-up you can skip this step and make the
changes to the machine settings once the machine is created.

The recommended size of the hard disk is 10000 GB.
() Do not add a virtual hard disk
() Create a virtual hard disk now
(®) Use an existing virtual hard disk file
Empty i)

Create Cancel
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Installing the Qt Environment

Then select Add:

Select Add

Lerem Ipsum - Hard Disk Selector
Mediurn

Add Refresh

Nar‘n1 Add Disk Image h Actual Size

Search By Mame ~

P D

Choose Cancel

Then select the supplied virtual disk image and select Create.

3.1.2 CREATING A SHARED FOLDER

Once the Virtual Machine has been created, a shared folder needs to be created to transfer the Qt
package on to the virtual machine. First, select the machine and select Settings:

f'l'j Oracle VM VirtualBox Manager

Eile  Machine Help

A vools

Windows
@ Inaccessible

22003

Select the Machine in the left,
then select Settings

@& 0P,

Mew  Settings Discard  Show

@ General
Settings (Ctrl+5)

Mame:
QOperating System:  Ubuntu {(54-bit)

|E| System

Base Memory: 1024 MB

Boot Crder: Floppy, Optical, Hard Disk

Acceleration:  VT-xfAMD-V, Nested Paging, KVM
Paravirtualization

@ Preview

|§] Display

Video Memaory: 16 ME
Graphics Controller: VMSYGA
Remote Desktop Server: Disabled
Recording: Disabled

Storage

Controller: IDE
IDE Secondary Master:  [Optical Drive] Empty
Controller: SATA
SATA Port 0: Ubuntu_16.04.6_&4bit.vdi (Mormal, 500.00 GE)

0 Audio

Host Driver:  Windows DirectSound
Controller:  ICH AC97

EF Network
Adapter 1: Intel PRO,/1000 MT Desktop (NAT)

(5 uss

USE Controller:  OHCI
Device Filters: 0 (0 active)

057-317 ISSUE: 1
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Installing the Qt Environment

'E:' Lorem Ipsum - Settings

E General

Systemn
Display
D Storage
Audio
Metwork
Serial Porfs

UsB

Shared Folders

W TR AR ON( L]

Uszer Interface

Shared Folders

Shared Folders

Mame Path

Machine Folders

Select Shared Folders

Then click Add

Access Auto Mount At E

Cancel

Select the folder path to the supplied Qt package. Use “Shared” for the Folder Name:

£ Edit Share ?

ot

Folder Path: | C:YUsers\Public\Downloads

> |

Folder Mame: |shared|

[ ] Read-only

[] Auto-mount | When checked, the gu

Mount paint: |

Cance

Start the Virtual Machine and ensure the shared folder is accessible. Start the machine, allowing it to
boot to the desktop, then install Guest Additions by selecting “Install Guest Additions CD Image”:

Page 15 of 36
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Installing the Qt Environment

Lorem Ipsum [Running] - Oracle VM VirtualBox - X
File Machine View Input Devices Help

@ Optical Drives »

{8 Audio > ry == -

1 B ® o) 930AM %

@ Network >

£ uss »

[C] Shared Folders »

[Z] Shared Clipboard »

[Z) Dragand Drop »

& Insert Guest Additions CD image...

Insert the Guest Additions disk file into the virtual optical drive B O k& o058 8]@ @ rioht cul

Wait for it to install, then reboot the virtual machine. Then, open a terminal (Ctrl+Alt+T) and type

sudo cp /home/user/shared/m812_qt_package.tar.gz /home/user/Desktop/; sudo
chown user:user /home/user/Desktop/m812_qt_package.tar.gz

The password for the user account is password. The package is how available on the desktop to
extract.

3.1.3 INSTALLING THE PACKAGE

Once the package is on the Desktop, it is ready to install. Double click it and extract it on the desktop.
Open a terminal on the Desktop (Ctrl+Alt+T) and run the command

cd ~/Desktop; ./install.sh

If prompted for a password, enter password. The virtual machine is now ready to compile and
program for the chosen device (DSEM812).
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Installing the Qt Environment

3.1.4 CHECKING THE KIT
Open Qt Creator:

Ubuntu Desktop ty B = «) 336PM &

m812_qgt pac ‘age.
m812_rsa_openssh
Qt Creator

- -

Examples sysroot.tar.gz

i

Documenctation

install.sh

ty B = ) 341PM {1

|5l Edit ©uild Debug Analyze Tools window Help

& New File or Project... ctri+N
[® Open File or Project... ctri+0

Open File With... - ‘ Search in Examples... |

Sessions »

Save All Ctrl+Shift+S

ctrl+Q

2\ Blogs

@ UserGuide

2. Type to locate (Ctrl... &l 1ssues 7Y search Results Applicatinn Output Compile Output QML Debugger ConsaleTest Results_
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Installing the Qt Environment

Choose an example from the Examples directory on the Desktop. Qt projects have the extension .pro.
In this case, the Examples/Touchscreen/Touchscreen.pro was selected:

Qt Creator 1 ﬂ = ) 3:42PM
File Edit =uilc Debug Analyze Tools Window Help

Open File
- © Recent 4 fduser  [@Desktop Examples Touchscreen
@ Home Name -~ Size Modified
[ Desktop = | main.cpp 375bytes 13Feb
D Documents a main.qml 2.8kB 13 Feb
Tutorials ) o L7 qml.grc 87bytes 13 Feb
~ D B Touchscreen.pro 172bytes 13 Feb
dd Music
&1 Pictures
New to Qt?
mm Videos
Learn how to develop your
own applications and ™ shared -
explore Qt Creator. =
© VBox_G -
Get Started Now =
+ Other Locatio.
L 0t Account
B Cnline Community
3\ Blogs
D) AllFiles -
@ UserGuide
Cancel Open

P, Type ko locate (Ct ih[1ssues A search Results EApplicatiun Output Compile Output- QML Debugger CDnleeTest Results_

Select M812 in the Build & Run section on the left:

Touchscreen - Qt Creator 1 E = ) 343PM {lF

Manage Kits... )b Build Settings
Edit build configuration: | Debug ~ Add | Remove | Rename.. | Clone...
Active Project General
Touchscreen ¥

Import Existing Build... Shadow build: v

Build directory: /home/user/Desktop/Examples/build-Touchscreen-M812-Debug Browse...
Build & Run !
Build Steps
o
= ms12 qmake: gmake Touchscreen.pro CONFIG+=debug CONFIG+=qml_debug Details ~
.iii\“ Make: make j1in /home/user/Desktop/! les/build-Touchscreen-M812-Debug Details ~

Project Settings Add Build Step -

Editor Clean Steps

Code Style

Dependencies Make: make clean -j1 in /home/user/Desktop/Examples/build-Touchscreen-M812-Debug Details ~
Clang Code Model Add Clean Step -

clang Tools Seanning QML Imports

Build Environment - -
Parsing QML Files

Use System Environment

2. Type to locate (Crl... i)l 1ssues JFA| Search ResultsAppli:atiun E Compile Out... QML Debugg... Ii General Mess...

Reading Project "Touchscreen”

) Test Results
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Installing the Qt Environment

Select the build button (hammer) in the bottom left:

Touchscreen - Qt Creator 1 E =P ) 3:44PM

Manage Kis... )lv Build Settings
Edit build configuration: | Debug ~ Add | Remove | Rename.. | Clone...
Active Project General
Touchscreen ¥

Shadow build: v

Import Existing Bui
Build directory: /home/user/Desktop/Examples/build-Touchscreen-M812-Debug Browse...

Build & Run
Build Steps

=

= ma12 qmake: gqmake Touchscreen.pro CONFIG+=debug CONFIG+=qml_debug Details ~
’iii‘“ Make: make -j1in /home/user/Desktop/! les/build hscreen-M812-Debug Details ~

Add Build Step -

Project Settings
Editor Clean Steps
Code Style
Dependencies Make: make clean -j1 in /home/user/Desktop/Examples/build-Touchscreen-M812-Debug Details ~

Clang Code Model

Clang Tools Add Clean Step ~

Build Environment

usesystem Environment oetls
| B Type to locate (Ctrl... 10| Issues JiFd Search ResultsEApplicatiun Compile Out... QML Debugg... Ii General Mess...-Test Results_

s,

If the build succeeds with no errors, you should have the following if opening the “Compile Output”
window:

Touchscreen - Qt Creator 1 E B ) 3:45PM {F

<no document>

Open a document

= File > Open File or Project (Ctrl+0)
= File > Recent Files

= Tools > Locate (Ctrl+K) and
- type to open file from any open project
Debug - type c<space><pattern>tojump to a class definition

- - type m<space><pattern>to jump to a function definition
.Iﬂ - type f<space><filename> to open file from File system
Projects - select one of the other filters for jumping to a location

= Drag and drop files here

Compile Output = Lol O Filter

Open Documents sysroot=/opt/dse/m8l2/arm-buildroot-linux-gnueabihf/sysroot -g -std=gnu++11 -Wall -W -D_REENTRANT -fPIC -DQT_QML_DEBUG -DQT_QUICK_LIB |+
=8 DQT_GUT_LTB -DQT_QML_LTB -DQT_NETWORK_LTE -DQT_CORE_LTE -T../Touchscreen -I. -T/opt/dse/m812/arm-buildroot-linux-gnueabihf/sysroot/

usr/include/qt5 -I/opt/dse/m812/arm-buildroot-1inux-gnueabihf/sysroot/usr/include/qt5/QtQuick —I/opt/dse/m812/arm-buildroot-Linux-

gnueabihf/sysroot/usr/include/qt5/Qteui ~I/opt/dse/m812/arm-buildroot-linux-gnueabihf/sysroot/usr/include/qt5/QtQml ~1/opt/dse/m812/

arm-buildroot-linux-gnueabihf/sysreot/usr/include/qts/QtNetwork -I/opt/dse/m812/arm-buildroot-linux-gnueabihf/sysroot/usr/include/qts/

QtCore -I. -I/opt/dse/m8l2/arm-buildroot-linux-gnueabihf/sysroot/usr/include -I/opt/dse/m8l2/mkspecs/devices/linux-buildroot-g++ -o

arc_gnl.o qrc_gnl.cpp

Jopt/dse/m812/bin/arm-buildroot-Llinux-gnueabihf-g++ --sysroot=/opt/dse/m812/arm-buildroot-linux-gnueabihf/sysroot -o Touchscreen

main.o grc_gml.c  -10tsQuick -1Qt5Gui -1Qtsoml -lQtsNetwork -1Qtscore -1rt -1d1 -latomic -L/opt/dse/m8l2/arm-buildroot-Tinux-

gnueabihf/sysroot/usr/lib ~1GLESv2 ~1EGL -lpthread

15:45:02: The process "/usr/bin/make" exited normally.

15:45:02: Elapsed time: 60:15.

[ I . Type to locate (Ctrl... il 1ssues JFAsearch ResultsEApplicatiun

QML Debugg... Ii General Mess...- Test Results.
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This project is now ready to download. Select the Run icon at the bottom left:

Touchscreen - Qt Creator 1 E B ) 3:46PM {lF

<no document>

Open a document

= File > Open File or Project (Ctrl+0)
= File > Recent Files
= Tools > Locate (Ctrl+K) and

- type to open file from any open project

- attern> to jump to a class definition
attern> to jump to a function definition

- type f<space><filename> to open file from File system
Projects - select one of the other filters for jumping to a location
» Drag and drop files here

(2] ‘ :

Help

Compile Output Lol O Filter

Open Documents sysroot=/opt/dse/m8l2/arm-buildroot-linux-gnueabihf/sysroot -g -std=gnu++11 -Wall -W -D_REENTRANT -fPIC -DQT_QML_DEBUG -DQT_QUICK_LIB |+
=8 DQT_GUT_LTB -DQT_QML_LTB -DQT_NETWORK_LTE -DQT_CORE_LTE -T../Touchscreen -I. -T/opt/dse/m812/arm-buildroot-linux-gnueabihf/sysroot/

usr/include/qt5 -I/opt/dse/m812/arm-buildroot-1inux-gnueabihf/sysroot/usr/include/qt5/QtQuick —I/opt/dse/m812/arm-buildroot-Linux-

gnueabihf/sysroot/usr/include/qt5/Qteui ~I/opt/dse/m812/arm-buildroot-linux-gnueabihf/sysroot/usr/include/qt5/QtQml ~1/opt/dse/m812/

arm-buildroot-linux-gnueabihf/sysreot/usr/include/qts/QtNetwork -I/opt/dse/m812/arm-buildroot-linux-gnueabihf/sysroot/usr/include/qts/

QtCore -I. -I/opt/dse/m8l2/arm-buildroot-linux-gnueabihf/sysroot/usr/include -I/opt/dse/m8l2/mkspecs/devices/linux-buildroot-g++ -o

arc_gnl.o qrc_gnl.cpp

Jopt/dse/m812/bin/arm-buildroot-Llinux-gnueabihf-g++ --sysroot=/opt/dse/m812/arm-buildroot-linux-gnueabihf/sysroot -o Touchscreen

main.o grc_gml.c  -10tsQuick -1Qt5Gui -1Qtsoml -lQtsNetwork -1Qtscore -1rt -1d1 -latomic -L/opt/dse/m8l2/arm-buildroot-Tinux-

gnueabihf/sysroot/usr/lib ~1GLESv2 ~1EGL -lpthread

15:45:02: The process "/usr/bin/make" exited normally.

15:45:02: Elapsed time: 60:15.

&l 1ssues lF) search Results Appli\:atiun .. R EE SRl oML Debugg... Ii General Mess... Test Resultsm

If the program starts on the M812, the kit is correct. This is assuming the M812 is connected to the
same network as the virtual machine and the M812 has the IP address of 192.168.1.100.

If the M812 has a different IP address, see section entitled Checking Connection to the Device
elsewhere in this document.
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4 CONNECTING TO QT

ANOTE: Prepare the Qt installation before following this section. See previous section
entitled Installing the Qt Environment elsewhere in this document.

ANOTE: Knowledge of Linux and Qt (QML, C++ and JavaScript) is essential and assumed.
This manual instructs the Qt programmer how to use Qt in conjunction with the DSE device.
This manual does not give instruction for Linux, Qt, QML, C++ or JavaScript.

Comprehensive online documentation for Qt is provided at https://doc.qgt.io/gt-5/

DSEMS812 Qt variant communicates with, and is programmed by, the Qt Integrated Development
Environment (IDE). Online documentation for the IDE is available at https://doc.qt.io/gtcreator/

4.1 FILE SYSTEM PATH

Description

/home/m812 Working folder for all user operations.
Contains Run.sh (boot time setup) and all applications that have been
deployed to the device.

4.2 CHECKING CONNECTION TO THE DEVICE

First use the device Settings Pages to configure the ethernet port as required. Full instructions how to
enter and utilise the Settings Pages are contained in DSE Publication 057-317 DSEMS812 Operator

Manual.
window Help
Locate... Ctri+k

C++
oMLJJs
Tests

Within Qt select
Tools | Options.

Code Pasting

Form Editor v
Parse Build Output...

External »
Diff »

| optons.._________|

ANOTE: Changing settings other than those detailed may cause unexpected errors.

Devices

& Kits Devices Android QNX | SSH

[ Enwironment Device: M812 {default For Generic Linux)

Then select Devices.

Home: Me12

B Text Editor

% rakevim

® nelp Type: Generic Linux —
{} Cos Auto-detected: No

Show Running Processes..
A Qecuick Current state: Unknown

Deploy Public Key..
2 Bulld&Run [N Open Remote Shell
Machine type: Physical ey

Authentication type: Tt = specific key

i Debugger

/ Designer
Host name: 192.168.1.28 ssport (22 |3 ¥ Checkhost key
¥ Analyzer

Freg 5 10000-10100 Timeout: 105 :

Username: m&12

Private key file: {/m12_rsa_openssh | Browse... || Create New.

[B Code Pasting

& Longuage Client GOB server executable:
an

1A Testing
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ANOTE: Changing settings other than those detailed may cause unexpected errors.

Devices

Devices | Android QNX = SSH

Device:  M812 (default for Generic Linux)
General

Name: M812
Type: Generic Linux
Auto-detected: No

Current state:  Unknown

Type Specific
Machine type: Physical Device

Authentication type: Default ® Specifigiey

Host name: 192.168.1.28 SSH port: 22
Free ports: 10000-10100 Timeout:  10s =
Username: m812

Private key file: /m812_rsa_openssh | Browse..  Create New...

GDB server executable: Leave emply tolo...

Ensure M812 is selected

And enter the IP address
of the device on your
network.

Click Test to check the settings and test the
connections to the device.

Name: MB12

Type: Generic Linux
Auto-detected: No

Current state: Unknown

Type Specific

Machine type: Physical Device

Authentication type: Default ® Specific key

Host name: 192.168.1.28 SSH port: 22 < ¥ Check host key
Free ports: 10000-10100 Timeout: [10s %

Username: m812

Private key file: J/m812_rsa_openssh| | Browse.. Create New..

GDB server executable: Leave empty to lo

Add...

Remove

Test
Show Running Processes. .
Deploy Public Key...
Open Remote Shell

Connecting to host...
Checking kernel version...

Linux 4.9.88_2.0.0-00018-g8F4019a armv7l /_

Checking if specified ports are available...
All specified ports are available.

Checking whether an SFTP connection can be set up...
SFTP service available.

Checking whether rsync works...
rsync is functional.

Device test Finished successFully.
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4.3 START NEW PROJECT

To begin, start a new project as shown.

Select File | New File or Project
Qt Creator

Edit =uild Debug Apd
B New File or Project...

lyze Tools Window Help

x New File or Project

Choose a template: All Templates

Projects

“ Qt widgets Application Creates a Qt Quick application that

Application contains an empty window.

Library

Other Project Qt Console Application
Non-Qt Project

Import Project Qt for Python - Empty

Supported P

Linux Device ) Select Application

Files and Classes

Cit Qt for Python - Window
Modeling

Qt !. Qt Quick Application - Empty
GLsL

General

sava " Then select Qt Quick Application - Empty
Python m Qt Quick Appli

Click Choose to continue M

* e

x Qt Quick Application - Empty

. Project Location
3 Location

Creates a Qt Quick application that contains an empty window.

Enter your project Name

And the location where the project is to

be stored on your PC.

Name: MyNewProject

Create in: | /home/user/Documents/M812Test

Use as default project location . .
Y Click Next to continue

Next > Cancel

Qt Quick Application - Empty

Define Build System

Location
¥ Build System  Build system: | qmake

\

Ensure gmake is selected

V Click Next to continue

<Back Cancel
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ANOTE: DSEMS812 is compatible with Qt 5.11. Selection of an incorrect Minimal required Qt
version may render project creation impossible.

(- Qt Quick Application - Empty

. Define Project Details
Location
Build System Minimal required Qt version: | Qt 5.11 v

7 Details Use QY Virtual Keyboard

Ensure Qt 5.11 is selected. This is the Qt
version supported by the device.

<Back Next > Cancel

o Qt Quick Application - Empty
) Kit Selection
Location
Build System The following kits can be used for project MyNewProject:
Details Type to filter kits by name...

P Kits ! select all kits

v/ = mg12 Details ~

o

Ensure M812 is selected.
If this is not correct, click Back and recheck
Minimal Qt Version is set to Qt 5.11.

< Back Next > Cancel
o Qt Quick Application - Empty
. Project Management
Location
Build System Add as a subproject to project:
Betal Add to version control: <None> ~* | Configure...
Kits
2 summary

Summary of the project
location and files to be
created.

Files to be added in
/home/user/Documents/M812Test/MyNewProject:

MyNewProject.pro Click Finish to continue

main.cpp

main.qgml
gml.qrc

< Back Finish Cancel
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The new project is created with a simple Window.

main.qml @ MyNewProject - Qt Creator
File Edit Build Debug Analyze Tools Window Help
Projects
~ lim MyNewProject
| @ MyNewProject.pro
¢ licd Sources
~ li# Resources
~ | @ gml.grc
~ W/
B main.gml

i

1 * Window {

1

B main.gml

dmport QtQuick 2.11
dmport QtQuick.Window 2.11

visible: true

width: 648

height: 480

title: gsTr({"Hello World")

However, we will modify this to provide a simple application to show something on the screen.

Aimport QtQuick 2.11

Amport QtQuick.window Cha

.11

nge width and height to suite the

device’s maximum screen size.

I = Window {

Add a text element

5 visible: true

B width: 1288

T height: a68 /_

- Text {
text: "My HNew Application"
visible: true
¥ (parent.width - width) J 2
y 0]
1 J

Y:0 places the top of Text at the
top of its parent (Window).

main.gml @ MyNewProjeckt - Qt g
g Edit Build Debug Analyze Tools

Projects
N~ iz MyNewProject

B MyNewProject.pro
¢+ licd Sources
~ li# Resources

~ | & gml.grc
v @/

lani mmain.gml

Double-Click on the .pro
(project) file n the Projects
window.

Change the target.path to ‘.’
——F oerault rules for

gnx: target.path =
29 else: unix:!android: target.path
lisEmpty (target.path): INSTALLS
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parent.width is the
width of Window (the
parent of Text)

width is the width of
Text.

(parent.width — width)/2
places the text centrally
within Window.

+= target
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Deploy the application as described in the section entitled Deploying the Application to the Device
elsewhere in this document.

Results of the application running on the device:

My New Application
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4.4 1/0
Device 1/O is controlled and read using dseio library. # Add the required DSE libraries
Add the library to LIBS within the .pro project file. LIBS += -ldseio
Include to any .h or .cpp files that use the library. #include "dseio.h”

// Imitialise the dseio library

Then initialised the library before use within main.cpp. dse_io_1ib_init();

ANOTE: For full details, see Examples\inputs and Examples\Outputs provided in the
DSEMS812 Qt package.

45 CAN

DSEMB812 is equipped with three CAN ports. Support for configuring them is provided using
Idsenetwork library.

Add the library to LIBS within the # Add the reguired DSE libraries
.pro project file. LIBS += -ldsenetwork

Within the cpp file include the #include <QCanBus>

required header files #include "cam.h"

finclude "dsenetwork.h"

Example CAN port configuration dse_network_can_config_t config;
250 = 250 kbit/s
O=Interface 0 (CAN1) config.size = sizeof(dse_network_can_config_t);

config.bitrate = 258;
config.id = 8;
dse_network_set_can_config{m_interface, &config):

4.5.1 PROCEDURE TO CONNECT TO THE CAN

ANOTE: A CAN application that does not receive CAN messages (used for transmit only)
must still implement the FramesReceived method. This provides a mechanism to retrieve
frames from the QCANBuUs device and prevents the receive memory overflowing.

ANOTE: For full details, see Examples\CAN provided in the DSEM812 Qt package.

Use dse_network _set _can_config to configure the device hardware.

Create the QCANBus SocketCAN.

Connect the SocketCAN to the device hardware,

Connect QCANBuSs device signal FramesReceived to the event handler within your own cpp
file.

e The event handler you provide for FramesReceived is used to filter and parse the incoming
CAN frames (messages) as required.
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46 GPS

ANOTE: A suitable external GPS antenna is required. For full specification see DSE
Publication 057-317 DSEM812 Operator Manual.

Within the QML file, the following imports are required:

import QtPositioning 5.11
import QtLocation 5.11

QML PositionSource item is used to retrieve the location at the given updatelnterval (ms).

/ Get the GPS location
PositionSource {
id: gpsloc
updateInterval: 1800
active: true

onPositionChanged: {

'/ Code to handle the change in position if required

}

4.7 DEPLOYING THE APPLICATION TO THE DEVICE

ANOTE: Successful communications with the device is required before deploying the

application. Refer to section entitled Checking Connection to the Device elsewhere in this
document.

4.7.1 ERROR CHECKING

ANOTE: Before clicking Run ensure there are no errors in the code. Many errors are
detected by Qt before compilation and are shown with red underlines in the code.

Text {
text: "My New Application"
visible: true

[+] x (parent.width - width) / 2 O Expected token el |

¥i ]

1

1
16

Error indication.

Error description. In this case a missing “:” after x.

Some errors are not detected until the project Build process. Press } to build (without deploying).
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ANOTE: Ensure Device Settings application is closed (exited) before sending your

application to the device. Failure to do this may result in multiple applications displaying items

on the display at the same time.

ANOTE: When updating an application on the device, ensure the ‘old’ version running on
the device is closed before writing the updated version to the device. For further details, see

section entitled Ceasing (killing) a Running Application elsewhere in this document.

ANOTE: The device accepts multiple applications to be installed to it at the same time. To

select the application to start at device boot up, refer to section entitled Selecting an

Application to Auto Run elsewhere in this document.

ANOTE: Where multiple applications are running on the device simultaneously, ensure
there is no conflict in the use of the display. It is recommended that only one application

utilises the display.

) main.qml @ MyNewProject - Qt Creator

Projects il Al o)
* iz MyNewProject
L= MyNewPgoject.pro

¢ licd Sources

- |ig Resources
! - L& gmlgrc
Design - ‘dl .
& B main.gml

Debug

Projects

e

Help

MyNe.. ject

Open Documents
main.gml*

File Edit Build Debug Analyze Tools Window Help
B main.gml*

import QtQuick Z.11
import QtQuick.Window 2.11

B3 <

16

* Window {

visible: true

width: 1280

height: 880

Text {
text: "My New Application"
visible: true
Xi (parent.width - width) [ 2
' e

Click s (Run) to build the application and

deploy to the device.
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4.8 SELECTING AN APPLICATION TO AUTO RUN

ANOTE: The device detects the presence of Run.sh and creates a new ‘factory set’ file if
not present.

To configure the device to automatically start an application upon device boot up we must edit Run.sh
on the device.

Options are

e Maintain a Run.sh file in the project folder. Deploy this file by adding the following to the
project file (.pro file)

scripts. files += S5PWD/run.sh

scripts.path = .
INSTALLS += scripts

This method is detailed within the Examples provided with the DSEM812 Virtual Machine
Package.

e Modify Run.sh in the location /home/m812 as detailed below :

window Help
) Locate... Ctri+K

/
C++ 4
QML/JS ’
Tesks »
Code Pasting

Within Qt select Tools | Options.

Form Editor v
Parse Build Output...

External »
Diff »

Then select Devices.

Devices

B Kis Devices | Android  QMX | SSH
[ Enviranment Device: | M812 {default for Generic Linux) Add.
B Text Editor J— Remove
FakeV|
¥ rokevien Name: ma12
@ Help Type: Generic Linux Test
0 con Auto-detected: No
{} ¢ Show Running Processes..
4 qrouick Current state:  Unknown

Deploy Public Key._.
ifi
2 Build & Run Type Specific Open Remote Shell

¥ Debugger Machine type: ical Device

/' Desiger Authenticationie: Default * Specifickey
¥ Analyzer 152.168.1.28 SsHpert: [22 |3 ¥ Check host key
& version control 10000-10100 Timeout: | 105

Username: mé12

[B Code Pasting

Private key file: {/m812_rsa_openssh | Browse... | Create New..
) GOB server executable: t
& Language Client

15 Testing
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Click Open Remote Shell to allow commands
to be actioned on the device. The shell is
opened at the location /home/m812/

Add...

Remove

Name: MB1
Type: Generic Linux Test
:uto-d:tetc:ed, :°k Show Running Processes...
urrent state: Unknown

Deploy Public Key...
Type Specific
Open Remote Shell

Machine type: Physical Device

Authentication type: Default ® Specific key

Host name: 192.168.1.28 SSHport: (22 |3 ¥/ Check host key
Free ports: 10000-10100 Timeout: | 105 -

Username: m812

Private key file: //m812_rsa_openssh| | Browse.. | Create New..

GDB server executable: Leave empty to

Type Is and press Enter to show a list of the
Tarminal files present in the /home/m812 folder.

Touchscreen run.sh

In this example CAN and Touchscreen are two
applications present on the device.

This is the Shell File that is run at device
bootup.

i,

Terminal
~ 5 1s

CAN Touchscreen run.sh
- 5 nano run.shfj

Type nano run.sh to open Nano (a text editor)
and edit the Run.sh file

ANOTE: The ‘factory set’ Run.sh’ contains clean-up code to gracefully close the application
should the calling process be terminated. This may be removed if desired, maintaining only
the APPLICATION variable naming the application to run at boot time.

Terminal

GNU nano 3.0 run.sh

eitnes Use Cursor Keys to move the cursor and after
A ER e APPLICATION=' enter /nome/m812/x0000xx
PPLICATION_LOGFILE=/var/log/app where xxxxxxxx is the name of the application
¢ Non-configurable variables you require to start at device boot. This name
PPLICATION_PID=/var/run/app.pid must match exactly the application name

¥ Trap SIGTERM and SIGINT (case sensitive).
leanup() {
echo "Caught signal... cleaning u

if [ -f SAPPLICATION_PID ]; then
start-stop-daemon -K --pidfile SAPPLICATION_PID

fi
killall S{basename "S{APPLICATION}")

walt "cat SAPPLICATION_PID®
exit @

Read 37 lines
Qe Get Help ¢ Write Out @Y Where Is @Y Cut Text [ Justify ae Cur Pos
4 Exit Wil Read File @ Replace WY Uncut Textgll To Spell @Ml Go To Line

Press CTRL X when done.
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Confirm changes.

Press Y — Save and exit.

Press N — Exit (discard changes)
Press CTRL C — Do not exit.

Save modified buffer? (Answering "No" will DISCARD changes.)
A Yes
Il Mo cancel

Close the Terminal window and power cycle the device to check the change.
If your application fails to start at boot up:

e Use Is to check the presence and exact spelling of the application on the device in folder
/home/m812. (Check case)
e Use Nano to check the path is correctly entered (case sensitive).

e Check the application by executing it directly from the Remote Terminal. Enter its name at the
command prompt.
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4.9 CEASING (KILLING) A RUNNING APPLICATION

To cease a running application, use a Remote Shell:

window Help
£ Locate... Ctrl+K

C++ b
QML/JS ’
Tesks »
Code Pasting ’

Form Editor L ]
Parse Build Output... Within Qt select Tools | Options.
External 3

Diff b

Devices
B Kits Devices | Android  QMX | SSH
[ Environment Device: | M812 {default for Generic Linux) = Add.
B Text Editor J— Remove
¥ Fakevim Name: ma12
@ Help Type: Generic Linux .
0 Ao deied: o s Then select Devices.
A ot quick Current state:  Unknown
oep)

2 Build & Run = Open Remote Shell
@ Debugger Machine type: Physical Device
# be Authentication type: Default Tihic key

signer
= ! Host name: 68.1.28 55H port: |22 + ¥ Check host key
¥ Analyzer
& verstoncontrl Free g 10000-10100 Timeout: | 105

ersion Control

‘Username: m12

[& Cade Pasting Private key file: /m812_rsa_openssh | Browse... || Create New..

GDB server executable:

& Language Client

15 Testing

ANOTE: Show Running Processes is an advanced option to list all running applications on
the device. The popup may also be used to stop those processes. However accidental use may

stop a critical process requiring a device reboot. For this reason, it is recommended to use
Remote Shell as detailed below.

Devices
Devices | Android | QNX  SSH

Device: | M812 (default For Generic Linux) z Add...

Remove

Click Open Remote Shell to allow commands
to be actioned on the device. The shell is mmm*:;mm__
opened at the location /home/m812/

Deploy Public Key...

Open Remote shell
Machine type: Physical Device
Authentication type: Default ‘e Specific key
Host name: 192.168.1.28 SSH port: | 22 < ¥/ Check host key
Free ports: 10000-10100 Timeout: | 10s -
Username: m812
Private key file: //m812_rsa_openssh| | Browse.. Create New...

GDB server executable: Leave empty to lo

Terminal

killall MyNewProject

s
S .
¥ Type killall followed by a
space and the name of the
running application. Then
press <Enter>
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5 MAINTENANCE AND WARRANTY

The device is Fit and Forget. As such, there are no user serviceable parts within the controller.
In the case of malfunction, you should contact your original equipment manufacturer (OEM).

DSE Provides limited warranty to the equipment purchaser at the point of sale. For full details of any
applicable warranty, refer to the original equipment supplier (OEM).

6 DISPOSAL
6.1 WEEE (WASTE ELECTRICAL AND ELECTRONIC EQUIPMENT) E

If you use electrical and electronic equipment you must store, collect, treat, recycle, and
dispose of WEEE separately from your other waste —

7 MISCELLANEOUS

This product includes copyrighted third-party software licensed under the terms of the GNU General
Public License. A copy of the corresponding source code for all included third-party software is
available on request, please contact DSE Technical Support for additional information.
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